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Introduction
This User Guide provides information about the G3090 GPS
receiver for MC90XX mobile computers from Motorola.
The G3090 GPS receiver is designed to snap on to the mobile
computer to provide GPS position information to applications
running on the device. The GPS receiver features a rugged plastic
housing that attaches to the MC90XX mobile computer using the device’s serial connector
for communication and power.
The G3090 GPS receiver has been tested for compatibility with the following operating
systems:


Windows® Mobile 2003



Windows® Mobile 2003 Phone Edition



Windows® Mobile 5.0



Windows® Mobile 5.0 Phone Edition



Windows® CE 5.0

The G3090 GPS receiver outputs GPS information as industry standard NMEA sentences
which are compatible with most GPS software applications. It can also be configured to
output GPS information in the SiRF Binary format.
G3090 GPS receivers offer typical accuracies of 3-5 meters uncorrected, and 3 meters or
1
better with Wide Area Augmentation System (WAAS) correction. They are tested to
comply with FCC and CE standards.
For detailed information on the Motorola MC90XX mobile computer, see the Quick
Reference Guide or Product Reference Guide for the mobile computer, available at
www.symbol.com/manuals.
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*Accuracy is subject to degradation based on environmental and positional conditions. Rated accuracy provides 95%
Circle Error Probability (CEP) position accuracies of <5 meters with WAAS correction and <10 meters uncorrected.
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Note: Screens and windows pictured in this User Guide are samples and may vary.

Connecting the G3090 GPS Receiver to the MC90XX computer
When attached to the mobile computer, the G3090 GPS receiver has the following
attributes:


Allows the mobile computer to capture GPS data.



Charges the mobile computer’s battery, when used with the appropriate power
supply.



Provides power for operating the mobile computer, with the appropriate power
connection.

To attach, snap the G3090 GPS receiver onto the bottom of the mobile computer. The
latch grips on the G3090 GPS receiver will engage the mobile computer for a secure fit.

To remove, squeeze the latch grips and pull the G3090 GPS receiver from the mobile
computer.

Remove the G3090 GPS receiver from the bottom of the mobile computer before using a
cradle for charging and communication.

ORBITGPS USER GUIDE
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Getting Started
Using the G3090 GPS receiver with an existing GPS application
The G3090 GPS receiver is designed to work “out-of-the-box” with GPS applications that
accept data in the NMEA protocol format.
The National Marine Electronics Association regulates the NMEA 0183 specifications
standard which defines a set of ASCII strings, called sentences, which relay GPS
navigation information. This is the most commonly used standard for GPS
communications.
To configure the G3090 GPS receiver for use with a GPS application that supports the
NMEA protocol, set the following parameters in the GPS application:


GPS Com Port or Com Port: COM1



Baud Rate: 4800



Protocol: NMEA (Depending on the GPS application, you may not be asked to enter
the protocol.)

Once these parameters have been set, the GPS application should begin automatically
receiving GPS data from the G3090 GPS receiver. Please consult the GPS application
documentation for further information on how to communicate with an attached GPS
receiver.

Using the G3090 GPS receiver with the G3090 GPS application
The G3090 GPS application provides a means to confirm proper operation of the G3090
GPS receiver and configure the mode of operation (NMEA or SiRF). Detailed instructions
on how to use the G3090 GPS application are included below.
The G3090 GPS application can be downloaded at www.OrbitGPS.com/GPSMC9000

WAAS & EGNOS Support
WAAS and EGNOS is a form of differential GPS correction that provide data that is used
to improve quality of the GPS data provided by GPS receivers. The G3090 GPS Receiver
will automatically acquire and utilize the correction data of WAAS or EGNOS satellites
available in the area of use. When WAAS or EGNOS data is in use, the GPS fix “Quality”
will show as “Corrected” in the G3090 GPS application.
For more information on WAAS visit:
http://gps.faa.gov/programs/waas/currentnews-text.htm

ORBITGPS USER GUIDE
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Charging the MC90XX through the G3090 GPS receiver
To charge the mobile computer’s battery through the G3090 GPS receiver, connect the
power supply to the G3090 GPS receiver, and then attach the G3090 GPS receiver to the
mobile computer. The mobile computer begins charging automatically.
The G3090 GPS receiver supports the Motorola 12 volt DC Power Supply (Part Number
VCA9000-12) and AC Power Supply (Part Number HP-O2040D43).

• 12V DC Power Supply (P/N VCA9000-12)

• AC Power Supply (P/N HP-O2040D43)

Batteries must be charged within the 32° to 104° F (0° to +40° C) ambient temperature
range.

ORBITGPS USER GUIDE
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GPS Evaluation Software
The GPS Evaluation Software provides a means to configure and confirm operation of the
G3090 GPS receiver. In the GPS Evaluation Software you will be able to choose the
mode of operation of the receiver and display positioning and performance information.
GPS Evaluation Software can be downloaded at http://www.orbitgps.com/support.htm

Tools Menu Options
Use the Tools menu to access configuration options or to exit the program.

The tools menu contains the following options:


Reset Receiver



Change Receiver Protocol



Configure

ORBITGPS USER GUIDE
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Exit

Important Note: When first using the G3090 GPS application, go to the Configure…
option first to set up communication between the G3090 GPS Receiver and Motorola
MC9000 mobile computer.
Reset Receiver
Use the Reset Receiver option to select the Start Mode and begin a new initialization of
the receiver.

Cold Start causes the receiver to release any fix information and completely re-initialize
navigation data (almanac, ephemeris, and clock). Typical “Time to First Fix” (TTFF) is 45
seconds or less.
Hot Start causes the receiver to keep existing navigation data and refresh the fix. Typical
TTFF is 8 seconds or less.
Change Receiver Protocol
Change Receiver Protocol causes the receiver to switch between the two available
modes of operation: NMEA or SiRF. NMEA is the default mode of operation for the
G3090 GPS Receiver for the Motorola MC90XX mobile computers.
When in NMEA mode, choose this option to switch to SiRF mode.
ORBITGPS USER GUIDE
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The G3090 GPS application requires the user to confirm switching the mode of operation
from NMEA to SiRF. To cancel the Change Receiver Protocol command, tap on
“Cancel.”

ORBITGPS USER GUIDE

8

G3090™ GPS FOR MOTOROLA MC90XX

When in SiRF mode, choose this option to switch to NMEA mode.

The G3090 GPS application requires the user to confirm switching the mode of operation
from SiRF to NMEA. To cancel the Change Receiver Protocol command, tap on
“Cancel.”
The Change Receiver Protocol also allows the user to choose which NMEA sentences
are to be communicated from the G3090 GPS receiver to the mobile computer. The
following NMEA sentences are supported by the G3090 GPS receiver:
GSV
Set this NMEA sentence to the update interval for the GNSS Satellites in view.
GLL
Set this NMEA sentence to the update interval for the Geographic Position: Latitude and
Longitude.
RMC
Set this NMEA sentence to the update interval for the Recommended Minimum Specific
GNSS Data.
GSA
ORBITGPS USER GUIDE
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Set this NMEA sentence to the update interval for the GNSS DOP and Active Satellites.
VTG
Set this NMEA sentence to the update interval for the Course Over Ground and Ground
Speed.
The default NMEA sentences for the G3090 GPS receiver are GGA, GSV, GSA and
RMC.
Configure
Use this option to configure the connection between the G3090 GPS receiver and the
Motorola MC9000 mobile computer.

Com Port
This value determines the PC communications port the GPS receiver is connected to. The
default for the G3090 GPS receiver for the MC90XX is: COM1.
Baud Rate
This value determines the Baud Rate (or data transfer rate) at which the GPS receiver
communicates with the mobile computer. The default for the G3090 GPS receiver for
the MC90XX is: 4800.
ORBITGPS USER GUIDE
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Protocol
This value determines the mode of operation to be used by the G3090 GPS receiver. The
default for the G3090 GPS receiver for the MC90XX is: NMEA.
Auto Detect
Use this option to have the G3090 GPS application automatically detect the Com Port,
Baud Rate and Protocol in use by the GPS receiver attached to the mobile computer.
OK and Cancel
Select “OK” to save the settings selected or “Cancel” to disregard any changes.
Exit
Use the Exit option to quit the G3090 GPS application return to the Windows Mobile
“Today” screen.
Important Note: To fully exit the G3090 GPS application, the Exit option must be used.
“Closing” the application by tapping on the “X” in the upper-right-hand portion of the screen
will not exit the program, but cause it to be minimized where it will continue running in
memory. If the G3090 GPS application is running in memory, it will block other GPS
applications from running properly on the mobile computer.

ORBITGPS USER GUIDE
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View Options
Use the View menu to choose how tracking information is displayed within the G3090
GPS application.

The tools menu contains the following options:


Navigation



Satellites



Raw Data

These options can also be selected by tapping on the following icons:

Navigation

Satellites

Raw Data
ORBITGPS USER GUIDE
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Fix Description
At the lower portion of the screen, just above the Tools menu, the G3090 GPS application
displays the type of fix currently acquired by the GPS receiver. This value can change
over time as the receiver’s viewable sky changes, or if the receiver is re-initialized. The
types of fixes are:


Invalid unavailable solution – This signifies that not enough satellite data is available
to provide a fix. This occurs as the receiver is initialized or when an insufficient
number of satellites are in the viewable sky.



Corrected 3D point solution – This signifies that a three-dimensional GPS fix is
available and that it is corrected using WAAS.



Uncorrected 3D point solution - This signifies that a standard three-dimensional GPS
fix is available.



Uncorrected 2D point solution – This signifies that a two-dimensional GPS fix is
acquired.

Navigation View
Use the “Navigation” view to display summary data for GPS fix information communicated
from the GPS receiver.

ORBITGPS USER GUIDE
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Parameters displayed in the Navigation view are:


Latitude – Displays the current location on the face of the Earth north or south of the
Equator. Latitude is an angular measurement ranging from 0° at the Equator to 90° at
the poles (90º N or 90º S). In the G3090 GPS application, North is shown as a
positive value and South is show as a negative value.



Longitude – Displays the current location on the face of the Earth east or west of a
north-south line called the Prime Meridian. Longitude is an angular measurement
ranging from 0° at the Prime Meridian to +180° east ward and −180° westward. In the
G3090 GPS application, East is shown as a positive value and West is show as a
negative value.



UTC – “Coordinated Universal Time or UTC,” is the equivalent of Greenwich Mean
Time, the astronomical basis for civil time.



Quality – Displays whether current fix is a “Normal” uncorrected fix or a WAAS
“Corrected” fix.



HDOP – “Horizontal Dilution Of Precision” is a measure of how the satellite geometry
influences the latitude and longitude data accuracy. A good satellite geometry and
hence a good accuracy is obtained if the satellites being tracked are located as far
away from each other as possible, while the geometry is poor if the satellites are
located close to each other. If the HDOP value is higher than about 10 the latitude and
longitude data likely to be inaccurate.



Speed – Displays the current velocity in miles per hour.



Heading – Displays the current direction of travel in degrees with North being 0°.



Sats Used – The number of satellites used in the current fix.



Protocol – The current mode of operation. This can be SiRF or NMEA.

ORBITGPS USER GUIDE
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Satellites View
Use the “Satellite” view to display summary data about the available satellites in the
viewable sky.

Parameters displayed in the Navigation view are:


Satellites – This column displays all satellites available in the viewable sky by the
identifying number of each satellite as determined by the GPS authorities.



SNR - This value indicates the carrier signal to noise ratio for the signal received by
the individual satellite. Typically, satellites with SNR values below 28 are not used in
GPS fixes.



Satellite Sky Map – This graphic image displays the relative position of the viewable
satellites overhead.

ORBITGPS USER GUIDE
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Raw Data View
Use the “Raw Data” view to display raw GPS signal data being received by the GPS
receiver.

Additional Options
Pause
Tapping the “Pause” icon temporarily pauses the GPS data stream being received by the
GPS receiver. To resume the GPS data stream, tap on the pause icon. When active, the
pause icon will have a gray background. When paused, the icon will have a white
background.

Pause Icon (unpaused)

Pause Icon (paused)

ORBITGPS USER GUIDE
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Specifications
Supported Operating Systems


Windows® Mobile 2003



Windows® Mobile 2003 Phone Edition



Windows® Mobile 5.0



Windows® Mobile 5.0 Phone Edition (Pending)



Windows® CE 5.0 (Pending)

Chipset
GPS Chipset:

SiRFstar III

Chipset Processor:

ARM7/TDMI – 49MHZ

Frequency:

L1, CA code

Receiver

Signal Acquisition:

200,000 effective correlators.

Channels:

20 Channels; all-in-view tracking

Max. Update Rate:

10Hz

Sensitivity:

-159dBm

DGPS Source:

WAAS/EGNOS

System Back Up:

Built-in Lithium-Ion rechargeable battery

Antenna Type:

Built-in Antenna (external antenna optional)

Position/Time Accuracy (without SA)
Autonomous:

<10 m

WAAS

<5m

Velocity:

0.1 meters/second

Time:

1 microsecond synchronized to GPS time

Datum:

WGS-84

Acquisition Rate
Reacquisition:
ORBITGPS USER GUIDE

100msec
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Hot Start:

<1 second

Warm Start:

<38 seconds

Cold Start:

<42 sec

Default:

NMEA-0183 (V2.20)- GGA(1), GSA(1), GSV(5), RMC(1)

Programmable:

Additional NMEA- VTG, GLL / SiRF Binary

Draw:

65mA at 4.5-5.5v

Internal Battery:

3v (for GPS module only)

Pass through:

Charging pass-through for mobile computer with barrel jack
connector

Protocol

Power

Dynamic Conditions
Altitude:

<18,000 meter

Velocity:

< 515 meter/second

Acceleration:

<4g

Environmental
Operating Temperature:

-20°C to +50°C

Storage Temperature:

-40°C to 70°C

Humidity:

5% to 95%, non-condensing

Thermal Shock:

-40°C to +70°C over 2 hours, 15 cyc les, non-operating

Impact (Drop):

6 ft. drop to concrete, 6 drops per 6 sides at 0°C, ambient
temperature (23°C) and +50°C (Note: Low end drop te st
temperature deviates from MC90XX PRD which is -20°C

Ruggedness:

Tumble; 250 cycles; 500 impacts

Vibration:

Sine 20-2000Hz, 4G peak

Physical Interface to Mobile Computer
Connector:

ORBITGPS USER GUIDE
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Dimensions
Depth:

38mm

Width:

80mm

Height:

101mm

Weight:

155g

Part Number
OrbitGPS part number:

LP11773R

Regulatory Information
Radio Frequency Interference Requirements
NOTE: This equipment has been tested and found to
comply with the limits for a Class B digital device.
pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against
harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encourages to try to correct the interference by one or
more of the following measures:
• Reorient or relocate the receiving antenna
• Increase the separation between the equipment and receiver
• Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected
• Consult the dealer or an experienced radio/TV technician for help
CAUTION: Changes or modifications to this equipment not expressly approved by the
party responsible for compliance could void the user’s authority to operate the equipment.

Statement of compliance
OrbitGPS hereby declares that this device is in compliance with the essential
requirements and other relevant provisions of Directives 1999/5/EC, 89/336/EEC and
73/23/EEC. Declaration of Conformities may be obtained from OrbitGPS on request.
ORBITGPS USER GUIDE
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The G3090 GPS has been tested to and found to comply with the following standards for
use within the Economic Union:

EMC Directive 89/336/EEC:
EN 55022:1998
EN 55024:1998 + A1:2001
R&TTE Directive 99/5/EC:
EN 301 489-3 V1.4.1 (2002-08)
Low Voltage Directive 73/23/EEC:
IEC 60950-1 1st Edition 2001 (National and group differences in
accordance with CB Bulletin No. 109A December 2005)
The G3090 GPS has also been tested and found to comply with:
Title 47 of the CFR:2004, Part 15, Subpart (b)
Class B Radiated Electric Field Emissions and Power Line Conducted Emissions
The G3090 GPS complies with:

RoHS Directive 2002/95/EC
Warranty
OrbitGPS’s hardware Products are warranted against defects in workmanship and materials for a period of twelve (12) months from
the date of shipment by OrbitGPS’s reseller to its customer, but in no event more than fifteen (15) months from shipment of the
Products by OrbitGPS, unless otherwise provided by OrbitGPS in writing, provided the Product remains unmodified and is operated
under normal and proper conditions. Warranty provisions and durations on software, integrated installed systems, Product modified
or designed to meet specific customer specifications (“Custom products”), remanufactured products, and reconditioned or upgraded
products, shall be as provided in the applicable Product specification in effect at the time of purchase or in the accompanying
software license; (b) Spare parts (i.e. Parts, components, or subassemblies sold by OrbitGPS for use in the service and
maintenance of Products) are warranted against defects in workmanship and materials for a period of thirty (30) days from the date
of shipment. Spare parts may be new or originate from returned units under the conditions set forth in subsection (d) below; (c) For
repairs on OrbitGPS-branded hardware Products under this Agreement, including repairs covered by warranty, the repair services
provided are warranted against defects in workmanship and materials on the repaired component of the Product for a period of thirty
(30) days from the shipment date of the repaired Product, or until the end of the original warranty period, whichever is longer; and (d)
Products may be serviced or manufactured with parts, components, or subassemblies that originate from returned products and that
have been tested as meeting applicable specifications for equivalent new material and Products. The sole obligation of OrbitGPS for
defective hardware Products is limited to repair or replacement (at OrbitGPS’s option) on a “return to service depot” basis with prior
OrbitGPS authorization. Solution Provider is responsible for shipment to OrbitGPS and assumes all costs and risks associated with
this transportation; return shipment to the Solution Provider will be at OrbitGPS’s expense. Solution Provider shall be responsible for
return shipment charges for product returned where OrbitGPS determines there is no defect (“No Defect Found”), or for Product
returned that OrbitGPS determines is not eligible for warranty repair. No charge will be made to Solution Provider for replacement
parts for warranty repairs. OrbitGPS is not responsible for any damage to or loss of any software programs, data or removable data
storage media, or the restoration or reinstallation of any software programs or data other than the software, if any, installed by
OrbitGPS during the manufacture of the Product; (e) Except for the warranty applying solely to the repaired component arising from
a repair service as provided in (c) above, the aforementioned provisions do not extend the original warranty period of any Product
that had either been repaired or replaced by OrbitGPS; (f) The above warranty shall not apply to any Product (I) which has been
repaired, tampered with, altered or modified, except by OrbitGPS’s authorized service personnel; or (II) in which the defects or
damage to the Product result from normal wear and tear, misuse, negligence, improper storage, water or other liquids, battery
leakage, use of parts or accessories not approved or supplied by OrbitGPS, or failure to perform operator handling and scheduled
maintenance instructions supplied by OrbitGPS; (III) which has been subjected to unusual physical or electrical stress, abuse, or
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accident, or forces or exposure beyond normal use within the specified operational and environmental parameters set forth in the
applicable Product specification; nor shall the above warranty provisions apply to any expendable or consumable items, such as
batteries, supplied with Product. EXCEPT FOR THE WARRANTY OF TITLE AND THE EXPRESS WARRANTIES STATED
ABOVE, ORBITGPS DISCLAIMS ALL WARRANTIES ON PRODUCTS FURNISHED HEREUNDER INCLUDING ALL IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR USE. ANY IMPLIED WARRANTIES THAT MAY
BE IMPOSED BY LAW ARE LIMITED IN DURATION TO THE LIMITED WARRANTY PERIOD. SOME STATES OR
COUNTRIES DO NOT ALLOW A LIMITATION ON HOW LONG AN IMPLIED WARRANTY LASTS OR THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR CONSUMER PRODUCTS. IN SUCH STATES OR
COUNTRIES, FOR SUCH PRODUCTS, SOME EXCLUSIONS OR LIMITATIONS OF THIS LIMITED WARRANTY MAY NOT
APPLY. The stated express warranties are in lieu of all obligations or liabilities on the part of OrbitGPS for damages, including but
not limited to, special, indirect or consequential damages arising out of or in connection with the use or performance of the Product or
service. OrbitGPS’s liability for damages to Solution Provider or others resulting from the use of any Product or service furnished
here under shall in no way exceed the purchase price of said Product or the fair market value of said service, except in instances of
injury to persons or property.
To the fullest extent allowed by law, the warranties and remedies set forth in this agreement are exclusive and in lieu of all other
warranties terms or conditions, express or implied, either in fact or by operation of law, statutory or otherwise, including without
limitation warranties terms or conditions of/as to satisfactory quality, merchantability, fitness for a particular purpose, conformance to
contract, correspondence with description and non-infringement, all of which are expressly excluded. OrbitGPS's warranties herein
are granted only to Distributor, and are not extended to any third parties that, for the avoidance of doubt, include any resellers,
agents or dealers of Distributor.
OrbitGPS neither assumes nor authorizes any other person to assume for it any other liability in connection with the sale, installation,
maintenance or use of its products, and OrbitGPS provides no warranty whatsoever for any non-standard Products supplied by it
hereunder.
ORBITGPS SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS TESTING AND EXAMINATION DISCLOSURE THAT
THE ALLEGED DEFECT IN THE PRODUCT DOES NOT EXIST OR WAS CAUSED BE DISTRIBUTOR’S, OR DISTRIBUTOR’S
RESELLER, OR END USER’S, OR ANY THIRD PERSON’S MISUSE, NEGLIGENCE, IMPROPER INSTALLATION OR
TESTING, UNAUTHORIZED ATTEMPTS TO REPAIR, OR ANY OTHER CAUSE BEYONE THE INSTALLATION OR TESTING,
UNAUTHORIZED ATTEMPTS TO REPAIR, OR ANY OTHER CAUSE BEYOND THE RANGE OF THE INTENDED USE, OR BY
ACCIDENT, FIRE, LIGHTNING OR OTHER HAZARD.

Service Information
Before you use the G3090 GPS receiver, it must be configured to operate with our mobile
computer and applications.
If you have a problem using the G3090 GPS receiver, contact your facility’s Technical or
Systems Support. If there is a problem with the equipment, they will contact the OrbitGPS
Support Center:
Email:

support@OrbitGPS.com

Telephone:

+1 203.654.7720

© 2009, OrbitGPS LLC
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